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About the BlackBerry Web Desktop Manager 1
The BlackBerry Web Desktop Manager is a web application that you can use to manage specific features on your
BlackBerry smartphone. You can open the BlackBerry Web Desktop Manager from a link in Microsoft Office 365.

Some of the actions that you can perform in the BlackBerry Web Desktop Manager are:

• Onboard your smartphone with the BlackBerry Business Cloud Services
• Back up and restore smartphone data and schedule automatic data backups
• Change email settings including email filters, message forwarding, and the signature that you want to add to

outgoing email messages
• View the number of email messages that you sent, forwarded and that are pending delivery
• Switch the data and services from your current smartphone to a new smartphone
• Create an activation password so that you can activate your smartphone over the wireless network
• In case your smartphone is lost or stolen, you can change your smartphone password and delete smartphone

data remotely

About the BlackBerry Business Cloud Services
The BlackBerry Business Cloud Services are services that are hosted by Research In Motion that allows you to use
your BlackBerry smartphone to access your Microsoft Office 365 email account, contacts, and other work
resources. All data is sent between Microsoft Office 365 and your smartphone using a highly secure link.

The BlackBerry Business Cloud Services allows your organization's administrators to manage your work email
account, assign your user account to specific groups, and apply IT policies and security settings as required by your
organization.

User Guide About the BlackBerry Web Desktop Manager
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Getting started 2

System requirements: Browser
Windows Internet Explorer 8 provides optimal support for BlackBerry Web Desktop Manager features. Depending
on the browser that you use, the BlackBerry Web Desktop Manager might not recognize your smartphone. You
must use Windows Internet Explorer to onboard your smartphone.

• Windows Internet Explorer 8
• Mozilla Firefox 3.6
• Safari 4 for Mac
• Google Chrome 4

Activating your smartphone to access work resources
You can activate your BlackBerry smartphone to associate it with your organization's environment and access your
work email account, work calendar, and other work applications on your smartphone. Use the following methods
to activate your smartphone:

• If you are activating a new smartphone, you can connect your smartphone to your computer and open the
BlackBerry Web Desktop Manager. The activation process begins automatically.

• If you are activating a new smartphone, you can activate your smartphone over the wireless network. Your
system administrator can provide you with an activation password, or you can create one yourself.

• If your smartphone is already activated and you need to move it from your current BlackBerry services host, for
example if you need to move your smartphone from Microsoft Online Services, to the BlackBerry Business Cloud
Services, you need to use the onboarding wizard to switch hosts.

• If your smartphone is already activated with BlackBerry Business Cloud Services, and you want to switch the
BlackBerry services and data from your current smartphone to a new smartphone, you can use the switch devices
feature.

Open the BlackBerry Web Desktop Manager
1. On the Microsoft Office 365 home page, in the Resources section, click Setting up email on mobile phones.

2. In the Hosted BlackBerry Services section, click BlackBerry Web Desktop Manager. Microsoft Office 365
redirects you to the BlackBerry Web Desktop Manager home page.

After you finish: The first time that you open the BlackBerry Web Desktop Manager, you might have to accept the
client authentication certificate and install the files that you need to use the BlackBerry Web Desktop Manager. To
install these files, you must have local administrator permissions for your computer.

User Guide Getting started
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Connect your smartphone to your computer using a USB
cable
1. Connect the larger end of the USB cable to a USB port on your computer.

2. Connect the smaller end of the USB cable to the USB port on the side of your BlackBerry smartphone.

3. On your computer, if the Device Security Password field appears, type your smartphone password. Click OK.

4. Click OK.

User Guide Connect your smartphone to your computer using a USB cable
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About onboarding 3
You can use the onboarding process to activate your BlackBerry smartphone when you move your smartphone
from the Hosted BlackBerry for Microsoft Exchange Online to the BlackBerry Business Cloud Services. The
onboarding process makes sure that your smartphone data and settings are transferred as well. When you
complete the onboarding process, you can access your work email account, calendar, and applications.

You can use one of two methods to onboard your smartphone:
• If your smartphone is running BlackBerry Device Software 5.0 or later, you can use the onboarding wizard.
• If your smartphone is running a version of BlackBerry Device Software that is earlier than 5.0, you can manually

onboard your smartphone.

Prerequisites: Using the onboarding wizard
• Verify that your BlackBerry smartphone is running BlackBerry Device Software 5.0 or later.
• Verify that you have administrator rights to your computer.
• On your smartphone, turn off encryption on the built-in media storage and the media card. If you do not turn

off encryption on the media card, you can not access the data after the onboarding process completes. For
information about turning off encryption, see the user guide for your smartphone.

• If you have a large amount of data stored in the built-in media storage, move data from the built-in media storage
to the media card. The onboarding process does not restore the built-in media storage on your smartphone if
the amount of data stored is more than 1 GB.

Use the onboarding wizard to activate your smartphone
The onboarding wizard automatically backs up the data on your BlackBerry smartphone, completes the steps
necessary to activate your smartphone, and restores the data to your smartphone after the activation process
completes. The onboarding process removes personal email accounts from your smartphone. After the
onboarding process completes, you need to set up your personal email accounts on your smartphone.

Before you begin: Disconnect your smartphone from your computer. Do not connect your smartphone to your
computer until you are instructed to do so in this procedure.

1. Open the BlackBerry Web Desktop Manager.

2. Click Run the onboarding wizard.

3. Read the conditions and notes and click Continue onboarding.

4. Connect your smartphone to your computer. The onboarding wizard begins automatically, do not disconnect
your smartphone from the computer until the onboarding process completes.

5. When the onboarding process completes, disconnect your smartphone from your computer.
After you disconnect your smartphone, the BlackBerry Business Cloud Services synchronizes your work data
over the wireless network. This process takes several minutes.

User Guide About onboarding
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After you finish: If required, set up your personal email accounts on your smartphone. For information about
setting up email accounts, see the user guide for your smartphone.

Manually onboard your smartphone
You can manually onboard your BlackBerry smartphone to activate it with the BlackBerry Business Cloud Services
if your smartphone is running BlackBerry Device Software that is earlier than 5.0, or if you are unable to use the
onboarding wizard. After you manually onboard your smartphone, you can set up your personal email accounts.

Before you begin: Back up the data on your smartphone using the BlackBerry Desktop Software. For more
information, see the Help in the BlackBerry Desktop Software.

1. Delete all data using the security wipe feature on the smartphone. Do not select the check box for the media
card. This process takes several minutes to complete.

2. When the smartphone restarts, open the BlackBerry Web Desktop Manager and complete one of the following
actions:
• Connect your smartphone to the computer. The activation process starts automatically.
• Create an activation password and activate your smartphone over the wireless network.

Do not disconnect your smartphone from the computer until the activation process completes.

After you finish:
• Set up personal email accounts on your smartphone. For information about setting up email accounts, see the

user guide for your smartphone.
• Optionally, restore your smartphone data using the BlackBerry Desktop Software. For more information, see

the Help in the BlackBerry Desktop Software.

User Guide Manually onboard your smartphone
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Create an activation password 4
If you need to activate your BlackBerry smartphone, and you did not receive an activation password from an
administrator or the activation password has expired, you can create an activation password and activate your
smartphone over the wireless network.

1. On the Advanced Settings tab, click Device Setup.

2. In the Enterprise activation password field and Confirm password field, type a password.

3. Click Set the enterprise activation password.

After you finish: To complete the activation process, type the password on the enterprise activation screen on
your smartphone.

User Guide Create an activation password
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Email settings 5

Stop forwarding email messages to your smartphone
1. On the Email Settings tab, in the General section, clear the Redirect incoming email messages to the device

check box.

2. Click Save.

Add a signature
You can create a signature that automatically displays in the email messages that you send from your BlackBerry
smartphone.

1. On the Email Settings tab, in the Signature field, type a signature.

2. Click Save.

Delete a signature
1. On the Email Settings tab, in the Signature field, delete the signature.

2. Click Save.

Store email messages that you sent from your smartphone
in the Sent Items folder of your email account
You can save the emails that you send from your BlackBerry smartphone, in the Sent Items folder of your email
account so that you can access them from your computer.

1. On the Email Settings tab, select the Save copy in Sent folder when sending an email message from the
BlackBerry device check box.

2. Click Save.

Manage contacts
You can manage how contacts from your private contact folders are saved on your BlackBerry smartphone, and
how contacts that you add on your smartphone are saved to your private contact folders.

1. On the Email Settings tab, click Contact Folders.

2. Perform any of the following actions:
• In the Private contact folders section, select the check box beside one or more private contact folders that

you want to add to the contact list on your smartphone. When you add a new contact to this folder, the
contact is added to contact list on your smartphone.

User Guide Email settings
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• In the Default private contact folder section, in the Default contact folder drop-down list, click a private
contact folder to synchronize with your smartphone. When you add a new contact on your smartphone, the
contact is added to this folder.

3. Click Save.

Forward email messages from a specific email folder to
your smartphone
You can forward emails that are saved to specific email folders on your computer to your BlackBerry smartphone.

1. On the Email Settings tab, click Redirection settings.

2. Select the check box beside one or more email folders. Email messages that are saved to the selected folders
are forwarded to your smartphone.

3. Click Save.

Delivery status for email messages and organizer data
If your BlackBerry smartphone is connected to your computer, you can view information about email messages
and organizer data on the Advanced Settings tab.

Statistic Description

Messages forwarded This field displays the number of email messages and organizer data items that the
BlackBerry Business Cloud Services forwarded to your smartphone.

Messages sent This field displays the number of email messages and organizer data items that you
sent from your smartphone.

Messages pending This field displays the number of email messages and organizer data items that the
BlackBerry Business Cloud Services did not yet forward to your smartphone. If your
smartphone is not connected to the wireless network, the BlackBerry Business Cloud
Services queues email messages and organizer data items for up to seven days and
forwards them when your smartphone is connected to the wireless network again.

Messages expired This field displays the number of email messages and organizer data items that the
BlackBerry Business Cloud Services could not forward to your smartphone within
seven days. The email messages and organizer data items that are not forwarded to
your smartphone remain in the email application on your computer.

Messages filtered This field displays the number of email messages that the BlackBerry Business Cloud
Services did not forward to your smartphone because the email filters that you set
on your smartphone prevented message forwarding or because your smartphone
was connected to your computer.

User Guide Forward email messages from a specific email folder to your smartphone

10



Email filters 6

About email filters
You can create email filters to specify which email messages are forwarded to your BlackBerry smartphone and
which remain in the email application on your computer.

Email filters are applied to email messages based on the order that they appear in your list of email filters. If you
create multiple email filters that could apply to the same email message, you must decide which one should be
applied first by placing that filter higher in the list.

Create an email filter
1. On the Email Settings tab, click Email Filter Settings.

2. Click Add new email message filter.

3. Set the email filter options.

4. Click Add new email message filter.

5. Click Save.

Options for email filters
When you create an email filter, you can set the following options.

Option Description

Filter name A unique name for the email filter.
From One or more contacts or email addresses that the email filter should search for in the

From field of email messages. You can separate multiple contacts or email addresses
with a semicolon (;). To specify that the email filter should search for all email
addresses that contain specific text, you can type the text and use an asterisk (*) as
a wildcard character to represent the rest of the email address.

Sent to One or more contacts or email addresses that the email filter should search for in the
Sent To field of email messages. You can separate multiple contacts or email
addresses with a semicolon (;). To specify that the email filter should search for all
email addresses that contain specific text, type the text and use an asterisk (*) as a
wildcard character to represent the rest of the email address.

Subject The text that the email filter searches for in the Subject field of email messages.
Body The text that the email filter searches for in the body of email messages.
Sent directly to me Email filter applies to email messages that include your email address in the To field.
CC: to me Email filter applies to email messages that include your email address in the CC field.
BCC: to me Email filter applies to email messages that include your email address in the BCC field.

User Guide Email filters
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Option Description

Importance The importance level of email messages that the email filter applies to.
Sensitivity The sensitivity level of email messages that the email filter applies to.
Do not forward email
messages to the device

Email messages that the email filter applies to are not forwarded to your smartphone.

Forward email messages
to the device

Option to forward email messages to your smartphone that the email filter applies
to. You can specify whether email messages are forwarded with high importance
(Level 1 notification) or with the email message header only and no body text.

Change an email filter
1. On the Email Settings tab, click Email Filter Settings.

2. Click an email filter.

3. Change the email filter options.

4. To select contacts or distribution lists in your organization's contact list, click the Import list icon beside the From
field or Sent to field.

5. Click Update Filter.

6. Click Save.

Change the order of email filters
1. On the Email Settings tab, click Email Filter Settings.

2. Click the Up Arrow icon or the Down Arrow icon.

3. Click Save.

Turn off an email filter
1. On the Email Settings tab, click Email Filter Settings.

2. Click the checkmark icon beside an email filter.

3. Click Save.

Delete an email filter
1. On the Email Settings tab, click Email Filter Settings.

2. Click the minus sign icon beside an email filter.

3. Click Save.
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Save all email filters
1. On the Email Settings tab, click Email Filter Settings.

2. Click Save Filters.

Open a saved email filter
1. On the Email Settings tab, click Email Filter Settings.

2. Click Load Filters.

3. Click an email filter (.rfi) file.

4. Click Open.

User Guide Save all email filters
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Backing up and restoring data 7

Back up smartphone data
You should back up the data on your smartphone periodically. You should make sure to back up the data before
you update the BlackBerry Device Software on your smartphone.

1. Connect your BlackBerry smartphone to your computer.

2. To include files that are saved to the built-in media storage in a back up file, on the Backup and Restore tab,
click Configure Backup Options and select the Back up on-board device memory check box. Click Save.

3. On the Backup and Restore tab, perform one of the following actions:
• To back up all your smartphone data, click Back up.
• To back up specific smartphone data, click Advanced. In the Device Databases section, select one or more

databases. Click the Left Arrow icon. On the File menu, click Save As.

4. Type a file name. Click Save.

Schedule automatic backups of smartphone data
1. Connect your BlackBerry smartphone to your computer.

2. On the Backup and Restore tab, click Configure Backup Options.

3. Select the Automatically back up my device check box.

4. Select the number of days between backups.

5. Perform one of the following actions:
• To back up all smartphone data, select the Backup all device application data option.
• To exclude email messages or organizer data, select the Backup all device application data, except for option

and specify the type of data to exclude.

6. Click Save.

Restore smartphone data
1. Connect your BlackBerry smartphone to your computer.

2. On the Backup and Restore tab, perform one of the following actions:
• To restore all smartphone data from a backup file, click Restore. Locate and double-click a backup file, that

has a .bbb file extension or .ipd file extension. Click Yes.
• To restore specific smartphone data from a backup file, click Advanced. On the File menu, click Open. Locate

and double-click a backup file that has a .bbb file extension or .ipd file extension. In the Desktop File Databases
section, select one or more databases and click the Right Arrow icon. Click Yes.

User Guide Backing up and restoring data
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Switching smartphones 8

About switching smartphones
You can use the switch device wizard to switch BlackBerry services from your current BlackBerry smartphone to a
new BlackBerry smartphone.

The switch device wizard transfers organizer data, calendar, email messages, and third-party applications that are
supported by your new smartphone from your current smartphone to your new smartphone. The switch device
wizard automatically starts the activation process to set up the connection to the BlackBerry Business Cloud
Services.

Switch smartphones
1. Connect your new BlackBerry smartphone to your computer.

2. Click Yes - Switch my BlackBerry services to this device.

3. Click Yes - Transfer the data.

4. Complete the instructions on the screen.

After you finish: Do not disconnect your smartphone from your computer until the smartphone data and services
are transferred to your new smartphone and the activation process on your new smartphone is complete. The
process is complete when the Change devices screen appears on your computer.

User Guide Switching smartphones
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Help protect a lost smartphone 9

Change your smartphone password
If your BlackBerry smartphone is misplaced and you might be able to recover it, you can use the BlackBerry Web
Desktop Manager to change your smartphone password and lock your smartphone to help protect the data.
Depending on your organization's security policies, you might not be able to change your password and lock your
smartphone.

1. On the Home tab, click Secure a Lost Device.

2. Click Specify new device password and lock device.

3. In the Device password field, type a new password.

4. In the Confirm password field, type the password again.

5. Click Specify new device password and lock device.

Delete all smartphone data and deactivate services
If your BlackBerry smartphone is misplaced or stolen, you can delete the data on the smartphone and deactivate
all services, such as email messaging and data synchronization. Depending on your organization's security policies,
you might not be able to delete data and deactivate services.

1. On the Home tab, click Secure a Lost Device.

2. Click Delete all device data and disable device.

3. Click Yes.

After you finish: If you recover your smartphone, you can activate the services again by either connecting your
smartphone to your computer using a USB cable or by creating an activation password so that you can activate
your smartphone over the wireless network.

User Guide Help protect a lost smartphone
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Troubleshooting 10

My computer cannot detect my smartphone
Perform one of the following actions:

• Verify that your BlackBerry smartphone is connected to your computer.
• Verify that the USB cable that you are using to connect your smartphone to your computer is not damaged.
• Turn off synchronization programs or antivirus programs temporarily.
• Verify that you are not running software that scans the communication ports on your computer.

I cannot access the features of the BlackBerry Web Desktop
Manager
Perform one of the following actions:

• Review the browser requirements and settings for the BlackBerry Web Desktop Manager. For more information
see the BlackBerry Enterprise Server Installation and Configuration Guide. To download this guide, visit
www.blackberry.com/go/serverdocs/.

• Contact your administrator for assistance.

I cannot send or receive email messages on my smartphone
Perform one of the following actions:

• Verify that your BlackBerry smartphone is connected to the wireless network.
• Verify that message forwarding is turned on and that you selected all the email folders, including your message

inbox, that you want to receive email messages from.
• If you generated a new encryption key, connect your smartphone to your computer to share the encryption key.
• Verify that your email profile options are correct. For more information, contact your administrator.

I cannot restore specific smartphone data
Perform one of the following actions:

• Verify that the database that you are trying to restore is not grayed out in the Device Databases section. If the
database is grayed out and the Right Arrow icon is not available, your BlackBerry smartphone might be configured
for wireless synchronization, wireless backup might be turned on, or the database might be read-only. For more
information, contact your administrator.

User Guide Troubleshooting
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• Verify that your smartphone has enough available memory to store the database. The amount of memory that
is displayed beside the database in the Desktop File Databases section might differ from the amount of memory
that is required to store the database on your smartphone. If the application memory on your smartphone is
low, consider deleting unused applications, data, or older email messages from your smartphone.

I cannot find the link for the onboarding wizard
To see the Run the onboarding wizard link in the BlackBerry Web Desktop Manager, you must open the BlackBerry
Web Desktop Manager before you connect your BlackBerry smartphone to your computer. If you open the
BlackBerry Web Desktop Manager after you connect your smartphone to your computer, the activation process
might start automatically before you can access the link to the onboarding wizard. If the activation process starts
automatically, it might not complete.

Some of my smartphone data is missing after the
onboarding process completes
When you activate your BlackBerry smartphone using the onboarding wizard, all of your work data is restored on
your smartphone. The following table includes the data that is not restored after you use the onboarding wizard. If
you are missing data that is not included in the table below on your smartphone after the onboarding process
completes, contact your organization's administrator.

Data Description

Personal email accounts The onboarding process removes personal email accounts from your
smartphone. You need to set up personal email accounts after the
onboarding process completes.

To set up your personal email accounts, click the Setup icon on your
smartphone.

Personal email messages After you set up personal email accounts on your smartphone, the
BlackBerry Business Cloud Services synchronizes the email messages from
your messaging service with your smartphone. This process can take a few
minutes.

BlackBerry Messenger contacts BlackBerry Messenger contacts are restored during the onboarding process.
If your contacts are missing, contact your administrator.

BlackBerry Messenger groups BlackBerry Messenger groups are not restored during the onboarding
process. You need to set up your BlackBerry Messenger groups after the
onboarding process completes.

Data in the built-in media storage The onboarding process restores the built-in media storage on your
smartphone unless the amount of data stored is more than 1 GB. If the built-
in media storage being used is larger than 1 GB, the data might not be
restored.
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Data Description

Data on the media card The onboarding wizard does not change data on the media card. If you
enabled encryption on the media card before you started the onboarding
process, the data might not be accessible.

The activation process did not complete
Perform one of the following actons:
• If you are onboarding your BlackBerry smartphone with the BlackBerry Business Cloud Services use the

onboarding wizard. If you connect your smartphone to your computer before you open the BlackBerry Web
Desktop Manager, the activation process will automatically start and will not complete. To access the onboarding
wizard you must open the BlackBerry Web Desktop Manager before you connect your smartphone to your
computer.

• Contact your administrator.

Error messages: Backup and restore
The Backup functionality is not available at your current location.

This message appears when you log in to the BlackBerry Web Desktop Manager from a computer that your
administrator restricted from performing backup and restore functions. For more information, contact your
administrator.

This function is no longer available to you. No changes have been made.
This message appears when your administrator changes your permissions since you last logged in to the
BlackBerry Web Desktop Manager. For more information, contact your administrator.
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Provide feedback
To provide feedback on this deliverable, visit www.blackberry.com/docsfeedback.
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Legal notice 11
©2012 Research In Motion Limited. All rights reserved. BlackBerry®, RIM®, Research In Motion®, and related
trademarks, names, and logos are the property of Research In Motion Limited and are registered and/or used in
the U.S. and countries around the world.

Mac and Safari are trademarks of Apple Inc. Google Chrome is a trademark of Google Inc. ActiveX, Microsoft,
Outlook and Windows are trademarks of Microsoft Corporation. Mozilla and Firefox are trademarks of Mozilla
Foundation. JavaScript is a trademark of Oracle America, Inc. All other trademarks are the property of their
respective owners.

This documentation including all documentation incorporated by reference herein such as documentation
provided or made available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS
AVAILABLE" and without condition, endorsement, guarantee, representation, or warranty of any kind by Research
In Motion Limited and its affiliated companies ("RIM") and RIM assumes no responsibility for any typographical,
technical, or other inaccuracies, errors, or omissions in this documentation. In order to protect RIM proprietary
and confidential information and/or trade secrets, this documentation may describe some aspects of RIM
technology in generalized terms. RIM reserves the right to periodically change information that is contained in this
documentation; however, RIM makes no commitment to provide any such changes, updates, enhancements, or
other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software,
products or services including components and content such as content protected by copyright and/or third-party
web sites (collectively the "Third Party Products and Services"). RIM does not control, and is not responsible for,
any Third Party Products and Services including, without limitation the content, accuracy, copyright compliance,
compatibility, performance, trustworthiness, legality, decency, links, or any other aspect of Third Party Products
and Services. The inclusion of a reference to Third Party Products and Services in this documentation does not
imply endorsement by RIM of the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS,
ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR
WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE
QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR
A COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR
PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY
PRODUCTS AND SERVICES REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS
THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF
IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR
CONDITIONS RELATING TO THE DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT
ABOVE, BUT CAN BE LIMITED, ARE HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED
THE DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL RIM BE
LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-
PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES
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REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT,
CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES,
DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS
OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED
IN CONJUNCTION WITH RIM PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF RIM PRODUCTS
OR SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF
COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT
SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF RIM HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, RIM SHALL HAVE NO OTHER
OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY
LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF
THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT,
NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL
BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY
CONTAINED HEREIN; AND (B) TO RIM AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS,
SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED RIM DISTRIBUTORS (ALSO INCLUDING
AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT
CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR,
EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF RIM OR ANY AFFILIATES OF RIM
HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure
that your airtime service provider has agreed to support all of their features. Some airtime service providers might
not offer Internet browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your
service provider for availability, roaming arrangements, service plans and features. Installation or use of Third
Party Products and Services with RIM's products and services may require one or more patent, trademark,
copyright, or other licenses in order to avoid infringement or violation of third party rights. You are solely
responsible for determining whether to use Third Party Products and Services and if any third party licenses are
required to do so. If required you are responsible for acquiring them. You should not install or use Third Party
Products and Services until all necessary licenses have been acquired. Any Third Party Products and Services that
are provided with RIM's products and services are provided as a convenience to you and are provided "AS IS" with
no express or implied conditions, endorsements, guarantees, representations, or warranties of any kind by RIM
and RIM assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and Services shall
be governed by and subject to you agreeing to the terms of separate licenses and other agreements applicable
thereto with third parties, except to the extent expressly covered by a license or other agreement with RIM.
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The terms of use of any RIM product or service are set out in a separate license or other agreement with RIM
applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN
AGREEMENTS OR WARRANTIES PROVIDED BY RIM FOR PORTIONS OF ANY RIM PRODUCT OR SERVICE OTHER
THAN THIS DOCUMENTATION.

Research In Motion Limited
295 Phillip Street
Waterloo, ON N2L 3W8
Canada

Research In Motion UK Limited 
Centrum House 
36 Station Road 
Egham, Surrey TW20 9LF 
United Kingdom 

Published in Canada
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